
 جزوه آموزش مایا

 (Autodeskطبق استاندارد همراه با جزئیات بیشتر برگرفته از سایت  2و1 )فصل  نسخه ویرایش نشده

 تدوین و ترجمه : طاهره مرادیان

 
 و شناخت محیط آن Autodesk Mayaافزار : توانایی نصب آخرین ورژن نرم2واحد کار 

 

 و کاربردهای آن  Autodesk Maya افزارنرمآشنایی با  -1-1/2
 Autodesk Maya هاسازیدر مدل افزارنرمافزاری قدرتمند در حوزه طراحی سه بعدی است. از این رمنبه مایا،  معروف، 

ای هناایهای رصنعت بازی ، سازی، انیمیشندر استودیوهای فیلمهای ویژه لوهج های سه بعدی،ساخت انیمیشنو سازی متحرک

 زبان با استفاده ازهسته اصلی مایا  .شودمیاستفاده  در هنرهای دیجیتالی نقاشی و همچنین طراحی سه بعدی در معماری،

C++ باشدمی مکینتاشو  ینوکسل های ویندوز،عاملروی سیستمو قابل اجرا  شده نوشته. 

 رفته است:قرار گاستودیوهای بزرگ سازنده فیلم و انیمیشن مورد توجه زیر، مختلف  امکانات به دلیل دارا بودنمایا 

 بسیار قویسازی ابزارهای مدل 

 تکنولوژی NURBS ( چمن، گیاهان، مو و مانندطراحی بهینه اشیاء طبیعی جهت ..).. 

 نور پردازی و در بالا توانایی Rendering (با استفاده از موتور قدرتمند  Mental Ray وArnold).  

 وجود  Materialهای متنوع. 

 سازیهای شخصیپذیری و قابلیتانعطاف (customization) و به آسانی(ه دلخواه بآن  )جهت تغییر محیط آن. 

 سازیکمتحرگذاری، ابزارهای ایجاد انیمیشن و امکان جلوه. 

  سی نویهای برنامهزباندارند )توسط افزار وجود نابزارها و امکاناتی که در نرمافزودن و افزار نرمامکان توسعهC++، 

MEL (Maya Embedded Language ،)Python) 

 گیرند. میقرار ( Scene) صحنهبه نام فضای مجازی عناصر بصری در مایا در یک 

 است. ma.یا  mb. پسوندهای ،های مایافایلسازی ولی فرمت اصلی ذخیره سازی بودهقابل ذخیرهزیادی  هایفرمتدر  صحنه

و هر گره، خصوصیات و  بودهمبتنی بر گره  هاصحنه .کندمیاستفاده  (Node) گره به نام مایا از یک ساختار گرافیکی افزارنرم

ه به کبه هم است  متصل  هایگره ای ازنمایش بصری صحنه براساس شبکه ،بنابراینمخصوص به خود را دارد.  تنظیمات

 یگر وابسته هستند.اطلاعات یکد

 ) مطالعه آزاد( مایا افزارنرمتاریخچه 

Autodesk Maya  ابتدا توسط شرکت Alias Systems شرکتبه متعلق  در حال حاضرو  طراحی Autodesk و توسط  بوده

) از  Advanced Visualizer در ابتدا یک محصول انیمیشنی نسل آینده مبتنی بر کد برنامهمایا یابد. این شرکت توسعه می

 که بود (Alias Sketch و Alias Research رکت)از ش PowerAnimator برنامه ( وWavefront Technologiesشرکت 

https://fa.wikipedia.org/wiki/%D9%85%DA%A9%DB%8C%D9%86%D8%AA%D8%A7%D8%B4
https://fa.wikipedia.org/wiki/%D9%85%DA%A9%DB%8C%D9%86%D8%AA%D8%A7%D8%B4
https://fa.wikipedia.org/wiki/%D8%B3%DB%8C_%D9%BE%D9%84%D8%A7%D8%B3_%D9%BE%D9%84%D8%A7%D8%B3
https://aryagostarafzar.com/siteimages/maya/Logo.png


 Wavefrontو Alias هر دو شرکت  Silicon Graphics پس از اینکه شرکتهای انیمیشنی به آن اضافه شد. ویژگی

Technologies  را خریداری کرد، تکنولوژی نسل آینده شرکتWavefront  با مایا ترکیب شد. این شرکت تابعه 

Alias|Wavefront  نامیده شد. 

 یپت نویسیاسکر زبان ،Wavefront کتراما پس از ادغام با شاستفاده شد   Tcl توسعه مایا از زبان اسکریپت نویسیابتدا جهت 

Sophia  در برنامه Dynamation  شد انتخاببه عنوان زبان مایا. 

Maya 1.0   توسط شرکت 2۰۰۵ها، مایا در سال عرضه شد. به دنبال یک سری ادغام 1۹۹۸در فوریه سال Autodesk ریداری خ

 تغییر یافت.   Autodesk Maya نام مایا بهه و شد

تری بالا متقیدارای  unlimitedنسخه شد که عرضه می Maya unlimited و Maya complete نسخه در دو 2۰۰۹تا سال مایا 

) ایجاد  Furملی، با حالت تعا کترابرای کار)تعریف لباس  Cloth چهار ویژگیدارای  ،completeعلاوه بر امکانات نسخه  بوده و

به بعد  2۰1۰از نسخه  نیز بود. اما (فیلم واقعیدر  Cgi عناصرو اشیاء و افزودن  دوربین مجازی)ایجاد  Live(، کترابرای کارمو 

  است. بیتی 64 و Maya 2018 . آخرین نسخه مایاشودمیو با تمام امکانات عرضه  نسخهفقط در یک 

مایا همکاری نزدیکی  افزارنرم، در توسعه Dinosaur دیزنی در طی مراحل تولید فیلم انیمیشنیاستودیوی انیمیشنی والت

اد کرد. این اری شخصی ایجسازی باشد تا بتوان یک روند کداشت. دیزنی درخواست داد که رابط کاربری برنامه قابل شخصی

 .مهمی بر روی ساختار آزاد مایا گذاشت و تا قسمتی دلیل محبوبیت آن در صنعت انیمیشن است موضوع تأثیر

 
 افزار مایابا نرم شده طراحی Frozen شنیمیاز ان ی  _ نما1شکل 

 
 ای از مایاهای ویزهبا جوله Witcher2نمایی از فیلم  _2 شکل

 



 
 مدل سازی _3 شکل

 Mayaافزار مورد نیاز برای نصب آشنایی با سخت -2-1/2
 است: ذیلبه شرح به بالا  2۰17نسخه  ایامافزاری جهت نصب افزاری و سختامکانات نرم

 ده:پشتیبانی شهای عاملسیستم  

o بیت 64های ویندوز پلتفرم( 7ویندوز ی (SP1) یا بالاتر) 

o mac (OS X 10.9.5) یا بالاتر 

o لینوکس (Red Hat Enterprise Linux 6.5 WS یا  CentOS 6.5)  

o پشتیبانی از سیستم عامل IRIX شرکت Silicon Graphics  و پشتیبانی از 6.۵بعد از ورژن openSUSE  Linux  

 .متوقف شد Maya 2009 در

 مورد نیازافزار سخت: 

o CPU :64-bit Intel or AMD multi-core processor with SSE4.2 instruction set 

o Graphics Hardware : 2حداقل GB  ز ابه سایت مایا مراجعه و بر اساس نسخه مایا  شودمی)پیشنهاد

 پیشنهادات سایت استفاده نمایید(

o RAM : 8حداقلGB  16ولی GB .یا بالاتر مناسب است 

o Hard : 4حداقل GB .فضای خالی نیاز دارد 

o ای استفاده نمایید.ترجیحاً از ماوس سه دکمه 
 

 Mayaافزار شناخت اصول نصب نرم -1-3/2
 آشنا خواهید شد. 2۰1۸در ادامه با مراحل نصب مایا نسخه 

  (www.patoghu.com) پسورد :   بیتی 46لینک دانلود نسخه 

 : 2017لینک دانلود مایا نسخه 

 قسمت دومو   قسمت اول

http://at1.cdn.asandl.com/software/design-graphics/animation/Autodesk.Maya.v2017.Update.3.x64_AsanDl.com.part1.rargraphics/an
http://at1.cdn.asandl.com/software/design-graphics/animation/Autodesk.Maya.v2017.Update.3.x64_AsanDl.com.part2.rar
http://at1.cdn.asandl.com/software/design-graphics/animation/Autodesk.Maya.v2017.Update.3.x64_AsanDl.com.part2.rar


ز حالت فشرده خارج نمایید.اآن را  دریافتی از سایت، با وارد کردن پسوردستاپ مایا، ابتدا  فشرده پس از دانلود فایل -1

 
 

و  Autodesk_Maya_2018_4_Update_dlm.sfxبا نام  setupفایل مطابق شکل با کلیک راست روی  ،در این مرحله -2

که  Autodesk هبه طور کامل در پوش setupفایل و منتظر بمانید تا  نماییدرا اجرا  آن Run as administratorفرمان  انتخاب

 Autodeskتوان نام پوشه ب نماید. )توجه: میشده و به طور خودکار شروع به نصکند از حالت فشرده خارج ایجاد می Cدر درایو 

 و محل آن را به دلخواه تغییر داد(

 



 
 را برای شروع نصب کلیک نمایید. Installگزینه  -3

 
 نمایید.را کلیک  Nextکمه و د انتخابرا  I Acceptجهت تأیید و ادامه نصب باید گزینه  -4



 



به ادامه  Installتوان مسیر نصب را تغییر داده؛ سپس توسط دکمه می Browseتوسط دکمه  Installation Pathاز بخش  -۵

توان را می ، میزان فضای مورد نیاز برای نصب برنامه و فضای موجود روی سیستم شماDisk Spaceاز قسمت  نصب بپردازید.

 مشاهده نمود.

 

 



کلیک را  Launch Now گزینههای همراه مایا، نامهت تیک سبز رنگ به نشانه نصب برپس از مشاهده علامدر این قسمت  -6

 نمایید.

 
 استفاده نمایید. Enter a Serial Numberجهت وارد نمودن شماره سریال برنامه از گزینه  -7



 
را  Enter Product Informationه نید جهت وارد نمودن شماره سریال گزپیام زیر را در هنگام نصب مشاهده نمودی اگر -۸

 کلیک نمایید.

 

  
 

را باز نمایید. همانند شکل زیر، شماره سریال  installرا باز نموده و فایل متنی  Patchفایل ستاپ دانلود شده، پوشه از پوشه  -۹

 .را کلیک نمایید Nextنموده و دکمه را در پنجره باز شده وارد  Product Keyو 



 
 سازی دارد و پنجره شکل زیر باز خواهد شد. کنید پس از نصب، نیاز به فعالاگر بار اولی است که برنامه مایا را نصب می -1۰

 نمایید. انتخابرا برای فعال نمودن برنامه  Activateگزینه 



 
دهد که می ید پنجره زیر را نمایشبار قبلاً عمل نصب را انجام داده باشید و برنامه را به دلایلی حذف و مجدد نصب نمایاگر یک

 را برای Finishدکمه  سازی ندارد و طبق پیام تصویر زیر، فایل مربوط به آن را روی سیستم پیدا نموده است.نیازی به فعال

 اتمام نصب کلیک نمایید.



 
 

را  Next و دکمه  انتخابرا  Request an activation code using an offline methodدر پنجره جدید باز شده، گزینه  -11

  کلیک نمایید.



 
 اآن را اجر Run as administratorفرمان  نتخاباو  xf-adsk2018-x64v3با کلیک راست روی فایل  setupاز پوشه فایل  -14

 نمایید. 

 
-xf-adsk2018ی فایل سازمایش داده شده را کپی نموده تا در پنجره فعالن، کد Request codeدر پنجره برنامه از بخش  -1۵

x64v3 .وارد نمایید 



 
وارد نمایید؛ سپس با کلیک روی  Requestاید را در قسمت در پنجره باز شده جدید، کدی که از بخش قبل کپی نموده -16

 نمایید. انتخابرا  Patchگزینه  ،ناایدر پ  تولید نمایید. Activationکد جدیدی در بخش  Generateدکمه 

 

 
 ها را بست. توان تمام پنجرهفقیت انجام شده و میا مونصب ب ،Successfully Patchedدر صورت مشاهده پیام  -1۸

 
 نکته  



طبق مراحل  اهر شدظصورتی که عملیات نصب با خطا مواجه شد و پیامی مبتنی بر نیاز به دارا بودن مجوزهای کاربر ادمین،  رد

سازی را تکرار ر فعالزیر کاربر ادمین اصلی برنامه را فعال نموده سپس با کاربر ادمین اصلی وارد ویندوز شوید و مجدداً مسی

 نمایید.

 خارج نمایید. انتخابرا از حالت  account is disableاز مسیر زیر، گزینه 
Control Panel  Administrator Tools  Computer Management  Local User and Group  Users  

Administrator   کلیک راست روی  Properties  account is disable  

 

 Mayaافزار های نرم Screen Componentشناخت اصول کار با  -4-1/2
 

 اجرای برنامه مایا:

 :توان به مایا دسترسی داشتدو طریق میاز  پس از نصب برنامه

  آیکون برنامه رویDesktop 

  فرض نصب برنامه در منوی پیشمسیرstart ویندوز:   

Start > Autodesk Maya  2018 >  Autodesk Maya 2018 

ر همانطور که د What's New Highlight Settingsو  Output Window ،Autodesk Mayaپس از اجرای برنامه، سه پنجره  

گذاری رنگ سبز علامت بههای جدید در مایا فرض، تمام ابزارها و آیکونشورت پیص به .شوندمینمایید، آشکار شکل مشاهده می

 شاینمنحوه  تنظیم برای What's New Highlight Settings، پنجره شدهنشان داده  ۳-1اند. همانطور که در تصویر شده

 رود. می ها به کارگذاریعلامت

 



 

 



 :Mental Rayپلاگین  افزودن

های برنامه مایا فعال نمایید. نسخه را در Mental Rayکنید باید پلاگین استفاده می 2016مایا نسخه قبل از در صورتی که از 

به  windowمنوی  از Mental Rayسازی پلاگین مراحل فعال .به صورت فعال هستند Arnoldبه بعد حاوی پلاگین  2016

  صورت زیر است: 

Window > Setting/Preferences > Plug-in Manager 

را  Mayatomr.mllط به فایل مربو Auto Loadو  Loadedهای گزینه ،Plug-in Managerوی کادر گفتگ پس از باز شدن

 کلیک کنید.  Close را و به دنبال آن کلید Refreshسپس روی کلید  نموده؛ انتخابمطابق شکل زیر 

 
 

 اجزاء مختلف فضای کار مایا:

 غیره است.وضعیت، شلف، جعبه ابزار و  نوارمنو،  نوار عنوان، نوارها،  viewportمایا شامل  محیط
 دهد. ین مرا نشا ر مایاف فضای کامختل ءاجزا شکل زیر

 



Workspace (فضای کار:)ی 

 workspaceها بسته به نیاز، فضای کاری گویند. انواع نحوه چیدمان آن وها و ابزارهای موجود در محیط کار به انواع پنجره

 دهیم:های این بخش را توضیح میهای موجود در مایا، در شکل زیر قابل مشاهده هستند. در ادامه، فرمان

 
Save Current Worksapce : 

ای در فضای کاری، کم یا زیاد نموده؛ سپس آن را به عنوان تواند به دلخواه چیدمان را تغییر و یا پنجرهکاربر مایا می

 ذخیره نماید.  Worksapceاز منوی  Save Current Worksapceفضای کاری دلخواه توسط فرمان 

 
Delete Current Worksapce : 

 Delete Current Worksapceتوان آن را توسط فرمان یشده توسط شما، متهدر صورت عدم نیاز به فضای کاری ساخ

 حذف نمود.



 
Reset Current Worksapce : 

ی کاری موجود را به ، فضاReset Current Worksapceتوان توسط فرمان در صورت به هم ریختگی فضای کاری، می

 حالت اول آن برگرداند.

 



Import Workspace Files : 

توانید فایل فضای کاری دلخواه را از خارج محیط مایا وارد این محیط ، میImport Workspace Filesفرمان  توسط

 نموده و استفاده کنید.

 

Title bar: 

 باشد.، میه فایل در آن ذخیره شدهک یآن، نام فایل و آدرس افزار و نسخهنام نرم و حاوی ی صفحه قرار گرفتهلابا درعنوان  نوار

 minimize ،maximize (restore)رای بپ، عنوان به ترتیب از چ نوارسمت راست  واقع درسه کلید : 

 .مایا است بستن پنجره و
 

1-4-1/2- Main Menu Bar (نوار )منوی اصلی 

 ،2018نسخه  مایا رد .است متفاوت، هاMenuset  به بسته شده داده یشنما منوی نوار نوع و دارد قرار عنوان نوار پایین، منو نوار

 .دارد وجود Rendering (F6) و Modeling (F2) ،Rigging (F3) ،Animation (F4) ، FX (F5)عنوان با یمتفاوت هایمنوست

 که دارد ودوج مایا در مشترک منوی ۹ حال این با. کنندمی تغییر ،شده انتخاب منوست اساس بر منو نوار در موجود وهایمن

، File ،Edit ،Create ،Select ،Modify،Displayاند از: منو عبارت ۹این . مانندمی ثابت شده، انتخاب منوست از رظنصرف

Widows ،Cache  وHelp منوی  2018. در نسخهArnold  ها نوستممنوی ثابت همراه تمام  10منو اضافه شده و  ۹هم به این

 .دهدیم نشان را Modeling منوست به مربوط منوی نوار زیر، شکل  شوند.نمایان می

 
های هر فرمان در منوها، علامت مربع مقابل آن فرمان را انتخاب نموده و هر منو حاوی زیر منوهایی است. جهت تنظیم گزینه

توان زیر منوی ها را تغییر دهید. در صورت وجود علامت فلش مقابل هر فرمان، با کلیک روی آن مینباز شده، آ پنجره از طریق

 آن را مشاهده نمود.

 
 

1-4-2/2 Status Line (وضعیت نوار) 

) Showکلید  توسط ابزارهای درون هر گروه است. های مختلفی از ابزارهاگروهگرفته و حاوی  قرار منو نوار پایین ،وضعیت نوار

 شوند.( مخفی می) Hide( نمایان و توسط کلید 

 

 
 ست:اکه به ترتیب از سمت چپ در لیست زیر آورده شده های مختلفی است نوار وضعیت حاوی گروه



 Menu set menu 
 File Icons 
 Selection Set Icons 
 Selection Mode Icons 
 Selection Mask Icon 
 Icons Snap   
 Symmetry Control 
 History  Icons 
 Render Tools Group 
   Select field 
 IPM Button 

  گروه کلیدهایPanel ها 

 پردازیم.به شرح کلیدهای نوار وضعیت میدر ادامه 

Menu set menu  : 

و  Modeling ،Animation ،Rigging ،FX حاوی منوهای یکشوی. این لیست قرار دارد  وضعیت نوار چپ سمتدر این بخش 

Rendering .فرض، گزینه به طور پیش استModeling سازی است.پروژه، مدل انتخاب شده است به این دلیل که اولین مرحله 

 
File Icons : 

 نیآخر)لغو و بازیابی  Redoو  Undoاز کردن صحنه موجود، ذخیره صحنه، بهایی جهت ایجاد صحنه جدید، حاوی دکمه

 که در ادامه توضیح داده شده است. (اعمال شده اتیعمل

 

   Create a new scene : 

  امیپ د؛ینک کیکل تیوضع نواردر  New Sceneید کل یرو ،کار نیانجام ا یشود. برایاستفاده م دیصحنه جد کی جادیا جهت

Warning: Scene Not Saved  Scene  ی با محتوا Save changes to untitled scene?ده نشان داده ش ریهمانطور که در تصو

و  Save دیآن کل رهیذخ ینشده باشد. برا رهیذخ یشود که صحنه فعلیم داریپد یزمان انهت ،اخطار امیپ نیشود. ایم نااینم

 رهیذخ و روندلغ ی. برانمایید انتخابرا  Don't Save دیکل ،یصحنه فعل راتییکردن تغ رهیبدون ذخ دیصحنه جد جادیا برای 

 .دیکن کیلکCancel  دیکل یرو

 



  Open a scene  : 

 د؛یکن انتخاب تیوضع رنوارا از  دیکل ،کار نیا ی. براشودیشده باشد استفاده م جادیا که قبلاً یلایباز کردن ف یبرا دیلاین ک

 Openدیلک یمورد نظر را مشخص کرده و رو لیفا یریمحل قرارگ ،پنجره نیشود. در ایم نااینم شکل مطابق Openپنجره 

 یبرخ یررسباست که در ادامه به  یمختلف یهاپنجره شامل قسمت نیا شد. باز خواهد ایما یفضا رشما د لیفا د؛یکن کیکل

 یم.پردازیها ماز آن

 
 

Folder Bookmarks : 

لدرها در فو دمانیچ دیتوانیم نی. شما همچنشودیشما استفاده م یهناایر یهابه پوشه یدسترس یبرا Bookmarks شبخ 

 .دیده رییتغ نییو پا لاا به باهرا با درگ کردن آن شبخ نیا

Set project : 

با عنوان  یاپنجره کلید نیا انتخاب. با شودیاستفاده م یآن با پروژه فعل ینیگزیو جا دیپروژه جد کی یمتنظ یبرا دیلک نیا

Set Project شود.می نمایان 

 Save the current scene : 

 شود. در کادر متنیم داریپد  Save Asی کادر گفتگو د،یکل نیا انتخاببا  .باشدمی ی کردن صحنه فعل رهیذخاین کلید برای 

File name  دیسپس کل ؛دیرا مشخص کن لیفا رهیذخ یمورد نظر برا ریمس د،یخود وارد کن لیفا ینام برا کی Save as را 

 هنگام دیتوانیکه م کندیم مشما فراه یرا برا یمختلف یهانهیگز ،ایشود. ما رهیشما ذخ یتا صحنه فعل کنید انتخاب

 .ستاداده شده  قرار Optionsسمت راست پنجره در قسمت در ها نهیگز نی. ادیها استفاده کناز آن لیفا یسازرهیذخ



 
 

  Undo the last action/Redo the last undone action : 

ال اعمجهت  action Redo the last undone دیلو از ک اعمال شده اتیعمل نیحذف آخر یبراUndo the last action کلید 

 .شودیحذف شده استفاده م اتیعمل نیمجدد آخر

Selection Set Icons  :  

ها، فقط آن انتخابکه با  باشدمیها ( آنComponentدهنده )و اجزاء تشکیلها نواع آبجکتجهت ا یاین بخش دارای لیست

 Selectionهای ، عناصر بخشهر گزینه از این بخش انتخاببا در صحنه وجود دارد.  Componentیا کت جآن آب انتخابامکان 

mode icon  وSelection mask icon کند. نیز تغییر می 

 
( فقط NURBS( و سمت چپ )polygonشده و از بین دو شکل سمت راست ) انتخاب Polygonدر شکل زیر عناصر از جنس 

 وجود دارد. polygon انتخابامکان 

 

 



Selection mode icons:  

 Select By Componentو  Select By Hierarchy And Combination ،Select by Object typesاین بخش دارای سه گزینه 

Type  .پردازیم.های این بخش میدر ادامه به بررسی گزینهاست 

 

 Select By Hierarchy And Combination: 

ها نمایش داده خواهند شد. به این معنی که اگر بندی آناین گزینه، عناصر بر اساس سلسله مراتب موجود و گروه انتخاببا 

ها، سایر عناصر گروه و سلسله مراتب یکی از آن انتخابچندین آبجکت در یک گروه یا سلسله مراتب قرار گرفته باشند، با 

  .باشدمیها نآنخواهند شد و نیازی به کلیک روی تک تک  انتخاب

 : هاآبجکت بندیگروه

 شتن کلید ها توسط کلیک روی آبجکت اول و نگهداآبجکت انتخابshift هاو کلیک روی سایر آبجکت. 

  کلیدهای فشردنCtrl + G. 

 ها )ایجاد والد و فرزند(:ایجاد سلسله مراتبی از آبجکت

  گهداشتن کلید نها توسط کلیک روی آبجکت اول و آبجکت انتخابshift دوم و کلیک روی آبجکت. 

  فشردن کلیدP. 

 و نگهداشتن کلید  دومتوسط کلیک روی آبجکت دوم  آبجکت انتخابshift لید کسوم و فشردن  و کلیک روی آبجکت

P ند.اتب قرار گیرنمایید تا در یک سلسله مر انتخابهای بعدی را و به همین ترتیب آبجکت 

 :ها از پنجره ها یا سلسله مراتبجهت نمایش گروه نکتهOutliner .استفاده نمایید 

 



 

 Select by Object types: 

های موجود  NURBSهای موجود در صحنه یا فقط  polygon. به طور مثال فقط شوندمی انتخابها عناصر بر اساس نوع آن

است و  شده انتخابدر صحنه به صورت یک شیء کامل و مجزا  NURBSدر شکل زیر، آبجکت  .شوندمی انتخابدر صحنه 

 نیست. انتخاباجزاء آن قابل 

 

 Select By Component Type: 

 Faceها یا  vertexتوان بر اساس را می polygon. به طور مثال، یک شوندمی انتخابها دهنده آنعناصر بر اساس اجزاء تشکیل

 شده است. انتخاب polgonاز یک  faceدر شکل زیر، یک  شود. انتخابهای آن و ... 

 
  : نکته 

 را فشار دهید.  F8، کلید ءو اجزا تآبجک انتخاب هایبین حالت ییبرای جابجا

 



Selection Mask Icon: 

 
 شهای نمایناست. آیکو شا از صفحه نمایهآن ءها یا اجزاآبجکت انتخاببرای  یشامل فیلترهای گزینشاین گروه های آیکون

 وابسته است.  selection mode iconگزینه انتخابی در بخش داده شده در این گروه به 

 کلید اگر Select by hierarchy and combinations  باشد انتخابدر حالت: 

 .کندفراهم میرا ها آن ها بر اساس سلسله مراتبامکان انتخاب آبجکت نمایش داده شده،های آیکون

 
 کلید اگر Select by object type در حالت انتخاب باشد: 

 .کندفراهم میا ر تآبجکامکان انتخاب  نمایش داده شده،های آیکون

 
 کلید اگر Select by component type در حالت انتخاب باشد: 

 .کندیآبجکت را فراهم م زاءاج داده شده، امکان انتخاب شینما یهاکونیآ

 
 

 پردازیم.های این بخش میدر ادامه به بررسی گزینه

 Set the object selection mask: 

، یکی از سه گزینه selection mode iconابتدا از بخش شود. یاستفاده می انتخابی هاتمام آیکون کردنفعال و غیر فعال جهت

 متناسب با انتخاب شما ظاهر شود. یقمنوی معلروی این کلید کلیک نموده تا موجود را انتخاب نموده؛ سپس 

 کلید اگر Select by hierarchy and combinations در حالت انتخاب باشد: 

 شود:کلیک نمایید، منویی به صورت شکل زیر نمایان می  ، روی دکمهselection mask iconدر بخش 

o Root .انتخاب ریشه یا والد : 

o Leaf .انتخاب برگ یا فرزند : 

o Template.انتخاب الگو : 

 

 
 کلید اگر Select by object type  باشد انتخابدر حالت: 

 شود:کلیک نمایید، منویی به صورت شکل زیر نمایان می ، روی دکمه selection mask iconدر بخش 

o All objects on  :های موجود در این بخشجهت انتخاب تمام آبجکت هاآیکون فعال نمودنرای ب. 



o All objects off  :ش.در صفحه نمای و عدم امکان انتخاب آبجکتی هاغیر فعال نمودن آیکونرای ب 

o Save to Shelfها در پنجره : جهت ذخیره این دکمهshelf. 

 
 کلید اگر Select by component type در حالت انتخاب باشد: 

 شود:به صورت شکل زیر نمایان میکلیک نمایید، منویی  ، روی دکمه selection mask iconدر بخش 

o All Components On:  جهت انتخاب تمام اجزاء موجود در این بخش هاآیکون فعال نمودنبرای. 

o All Components Off:  ش.در صفحه نمای آبجکتی اجزاء ها و عدم امکان انتخابغیر فعال نمودن آیکونبرای 

o Save to Shelf: ها در پنجره جهت ذخیره این دکمهshelf. 

 
  :Save to shelfاز  1 مثال

 را دنبال نمایید.زیر مطابق شکل زیر، مراحل 

 .selection mode iconبخش  از Select by object type کلیدانتخاب  .1

انتخاب تمام انواع  جهت All objects onگزینه و انتخاب  selection mask iconاز بخش  دکمه کلیک روی  .2

 .هاآبجکت

 maskآیکون جهت قرارگیری  Save to Shelfگزینه و انتخاب  selection mask iconاز بخش  دکمه کلیک روی  .۳

 .(sculptingجاری ) shelfبا قابلیت انتخاب آبجکت در مجموعه 

 .selection mode iconبخش  از Select by component type  کلیدانتخاب  .4

 .sculpting مربوط به بخش shelfدر نوار  کلیک روی آیکون  .5

جزاء انتخاب شده است و باید ا selection mode iconبخش  از Select by component typeدر این مثال، با وجود اینکه 

، امکان آیکون ماسک و کلیک روی آبجکت درون صحنه انتخابآبجکت قابل انتخاب باشد ولی مشاهده خواهید کرد که با 

 Select byبه  select mode iconاز بخش  Select by component typeفراهم شده است و گزینه  cylinderآبجکت انتخاب 

object type کند.به صورت خودکار تغییر می 



 

 
 : Save to shelfاز  2مثال 

 نمایید. مطابق شکل زیر، مراحل زیر را دنبال

 .selection mode iconبخش  از Select by component type کلیدانتخاب  .1

انتخاب تمام  جهت All Components Onگزینه و انتخاب  selection mask iconاز بخش  دکمه کلیک روی  .2

 .آبجکت اجزاء

 maskآیکون جهت قرارگیری  Save to Shelfو انتخاب گزینه  selection mask iconاز بخش  کلیک روی دکمه  .۳

 .(sculptingجاری ) shelfآبجکت در مجموعه  اجزاء با قابلیت انتخاب



 .selection mode iconبخش  از Select by object type کلیدانتخاب  .4

 .sculpting مربوط به بخش shelfدر نوار  کلیک روی آیکون  .5

کت قابل انتخاب شده است و باید آبج selection mode iconبخش  از Select by object typeدر این مثال، با وجود اینکه 

خاب اجزاء انتخاب باشد ولی مشاهده خواهید کرد که با انتخاب آیکون ماسک و کلیک روی آبجکت درون صحنه، امکان انت

 Select by componentبه  select mode iconاز بخش  Select by object typeفراهم شده است و گزینه  cylinderآبجکت 

type کند.به صورت خودکار تغییر می 

 

 



 Select handle object: 

 شود.یاستفاده مها  Selection handleها و   IK handle انتخاب جهت

 

  Select Joint objects :  

 شود. یاستفاده م سازیکمتحرهای آبجکت هنگام ریگ کردن و  Skelton joint انتخاب جهت

 
  

  Select curve objects : 

 .باشدمیهای روی صفحه نمایش  Paint Effects Strokeها و  Curves on Surfaceها،  NURBS Curve انتخاب جهت

 

  Select surface object: 

 شود. یاستفاده م شدر صفحه نمایها  GPU Chaceو  Polygon ،Planes، سطوح NURBSسطوح  انتخاب جهت

 

  Select deformation objects : 

 شود. یاستفاده م شیافحه نمدر ص sculptهای آبجکتو  nonlinear ها، cluster ها، lattice انتخاب جهت

 

  Select dynamic objects : 

، Paticles ،Emitters ،Fields ،Springs ،Riggid bodies ،Riggid Constraints ،Fluidsی از نوع هایآبجکت انتخاب جهت

Hair systems ،Follicles ،nCloths ،nRigids وDynamic Constraints شود. یاستفاده م شدر صفحه نمای 



 

  Select rendering objects: 

 .شودمیاستفاده  شها در صفحه نمای textureها و نورها، دوربین انتخابجهت 

 

  Select miscellaneous objects: 

 . شودمیه استفاد شها در صفحه نمای dimensionها و  locatorها ، IK End Effectorمتفرقه مثل  هایآبجکت انتخاب جهت

 

 Lock/Unlock current selection : 

فقط  ،هاجکتآب انتخابصورت که کلید چپ ماوس به جای  این به شودمیاستفاده  ،انتخابدر حال  عناصرقفل کردن  جهت

نید و روی کلید ک انتخاب صحنهرا در  آبجکت. یک کندمیعمل ( moveو  scale ،rotateهای )دستگیرهها  manipulatorروی 

Lock/Unlock current selection  وضعیت کلیک کنید؛  نواردرmanipulator  و هیچ آبجکت  شوندمیآن قفل  به آبجکتهای

 کرد.  انتخاب تواننمیدیگری را در صحنه 

  Highlight Selection mode: 

نگام انتخاب ه شود.میبه صورت خودکار آبجکت  انتخاب کلبا انتخاب این گزینه، روی حالت نمایش اجزاء قفل شده و مانع از 

 .شودغیرفعال می به صورت کلی در هر حالت جزئی، انتخاب شیء ءاجزا

 :مثال

 مراحل زیر را دنبال نمایید:

 شکل سمت چپ :

 .selection mode icon از بخش select by component typeکلید انتخاب  .1



 .selection mask iconاز بخش   faceانتخاب گزینه  .2

 از آبجکت. face انتخاب سه  .۳

 شکل سمت راست:

 .selection mode icon از بخش select by object typeکلید انتخاب  .1

 مشاهده خواهید کرد که کل آبجکت انتخاب خواهد شد. .2

 
 

 سمت چپ : شکل

 .selection mode icon از بخش select by component typeکلید انتخاب  .4

 .selection mask iconاز بخش   faceانتخاب گزینه  .5

 از آبجکت. face انتخاب سه  .6

 شکل سمت راست:

 .selection mask iconاز بخش    Highlight selection modeانتخاب کلید  .7

 .selection mode icon از بخش select by object typeکلید انتخاب  .8

نتخاب اکل آبجکت در حال انتخاب است و مانع از انتخاب خودکار  faceهمچنان همان سه مشاهده خواهید کرد که  .۹

 شده است.



 
 

Icons Snap  : 

در ادامه به بررسی  روند.می کاربه حنه در ص یشده به نقاط مشخص انتخاب هایآبجکتچسباندن  جهت Snap کلیدهای

 پردازیم.های این بخش میگزینه
 

  

  Snap to grids : 

کت روی رئوس حرکت آبج. شودمی استفاده gridع صفحه طندن آبجکت به نزدیکترین نقطه تقابرای چسبا Snap to gridsکلید 

 است. Xبر آن، کلید میانشود. های گرید انجام میمربع

 مراحل زیر را دنبال نمایید: ،grid صفحهع اطبه نزدیکترین نقطه تق sphereچسباندن یک : جهت مثال

 .viewportروی کلیک  و Sphereفرمان توسط  NURBS Primitives < Objects < Create از مسیر sphereایجاد یک  .1

 .وضعیت نواراز  Snap to grids ابزارانتخاب  .2

 جهت مشاهده بهتر حرکت آبجکت روی نقاط تقاطع خطوط گرید. sideانتخاب نمای  .۳

 .از جعبه ابزار Move ابزارانتخاب  .4

کترین نقطه به نزدی sphereآن را بکشید؛  ،و با نگهداشتن کلید کرده انتخابرا  sphere ،ماوسبا کلید وسط  آنگاه .5

 . چسبدمی grid صفحه



  

  Snap to curves : 

 است. Cبر آن، کلید میان. شودمیدر صحنه استفاده  curve به آبجکتبرای چسباندن  Snap to curvesکلید 

 :curveمکعب به  یک چسباندن جهت ،مثال

کلیک روی  از نوار منو وCube < NURBS Primitives < Objects < Create  دستورترسیم یک مکعب با انتخاب  .1

viewport. 

 د )فشردن کلی منو نواراز  EP Curve Tool < Curve Tools < Createدستور توسط  topدر نمای ترسیم یک منحنی  .2

ENTER  از ابزار  جهت خروج کیبوردرویEP Curve Tool.) 

 .curveی لابابه مکعب حرکت از جعبه ابزار و  Move Toolابزار انتخاب  .۳

 .Snap to curves کلیدانتخاب  .4

 ؛ نماییددرگ و  گرفتهمکعب را  ،کلید وسط ماوس توسط .5

 . کندحرکت می cuve سمت به کلیدهنگام استفاده از این  ،مکعبنمایید که مشاهده می

  



 

  Snap to points: 

 .شودیم استفاده pivotه نقط یا control vertex تریننزدیکشده به  انتخاببرای چسباندن آبجکت  Snap to pointsکلید 

 است. Vبر آن، کلید میان

 :polygon planeیک  های vertex بهچسباندن یک مکعب  مثال، جهت

 Plane ، روی علامت مربع جلویواقع در نوار منو Create > Polygon Primitives  > Planeدر مسیر : planeترسیم  .1

 کنید یفتعر 10را  Height divisionsو  Width divisions مقادیر لحاکلیک نمایید تا پنجره تنظیمات آن باز شود. 

 . شود ایجاد planeکلیک کنید تا یک  viewportروی  سپسو 

 آن. انتخابو  viewportمکعب در  یک ترسیم .2

 .نوار وضعیتاز  Snap to pointsکلید انتخاب  .۳

 .درگ نماییدو  گرفتهوسط ماوس  کلید توسطب را مکع .4

 . چسبدمی polygon planeاز  control vertex تریننزدیک بهمکعب کنید که مشاهده می



 

 

 Snap to Projected Center  : 

این کلید  .شودمیاستفاده  دیگر ی( به مرکز آبجکتlocatorیا  joint) آبجکت چسباندن برای Snap to Projected Centerکلید 

  فعال باشد به دیگر کلیدها ارجحیت دارد. snapاگر همراه با دیگر کلیدهای 

 :polygon planeبه مرکز یک  locatorمثال، برای چسباندن یک 

شانگر ن دگر منو و نواراز  Plane < Polygon Primitives < Objects < Create دستورتوسط انتخاب  planeایجاد یک  .1

 .ماوس

 .از نوار منو Locator < Createستور دتوسط  locatorایجاد یک  .2

 .locator انتخاب .۳

 .وضعیت نواردر  Snap to Projected Centerکلید انتخاب  .4



 چسبد. می planeبه  locator که کنیدمشاهده می

 Snap to view planes  : 

 چسباند. می viewport شنمای صفحهشده را به  انتخابآبجکت  Snap to view planesکلید 

 Make the selected object live : 

 liveبجکت آ از. رودبه کار می liveشده به یک آبجکت  انتخاب حکردن سطبرای تبدیل Make the selected object liveکلید 

 . کننداستفاده میآن  حروی سط ها مستقیماً curveها یا ایجاد آبجکت جهت

 :sphereیک  حروی سط cube یکچسباندن  مثال: جهت

شید تا کرا  ماوسکنید و نشانگر  انتخابمنو  نواررا از Sphere < Polygon Primitives < Objects < Create   دستور .1

sphere  .ایجاد شود 

 sphere کنید؛ انتخابوضعیت  نواررا از  Make the selected object live، کلید sphere سطحروی  مکعب ایجاد برای .2

 شود.داده می شسبز رنگ نمای wireframeبا 

 یک؛ درگ نماییدرا  ماوسنگر اکنید و نش انتخابرا Cube < Polygon Primitives < Objects < Create دستور  .۳

 . شودمیایجاد  sphere سطحمکعب بر روی 

  
Symmetry Control: 

نظیر های فهمول به همراههای انتخاب شده شود، مولفهمیفعال  Symmetryکه  زمانیمبتنی بر انتخاب است.  ،تقارن در مایا

 یابد.از یک ابزار به دیگری ادامه می فعلی، Symmetry اتد. تنظیمنشودر طرف مقابل مش انتخاب میها آن

 بر آن:کلید میان

 .Symmetryفشردن کلید وسط ماوس روی منوی کشویی 

 انتخاب نمود. Zو  X،  Yرا به صورت قرینه در راستای محور  های مختلف انتخابیتوان بخشی این ابزار میهابا تنظیم گزینه

Symmetry ،)کند.میدل چند ضلعی به سمت مقابل منعکس جزئیات را از یک طرف م )تقارن 



 
 

 

 
 پردازیم:های این ابزار میدر ادامه به بررسی گزینه

Off: 

 شود.این ابزار استفاده می حالت تقارن کردنجهت غیر فعال

 متقارن آن انتخاب نخواهد شد. faceاز یک مکعب انتخاب نمایید،  faceمثال: اگر یک 

 



Object X: 

 کند.ایجاد می Xحالت تقارن بخش انتخابی در راستای محور  

 faceانتخاب  متقارن آن نیز انتخاب خواهد شد. جهت X ،faceروی مکعبی انتخاب شود، در راستای محور  Faceمثال: اگر یک 

 کند.( استفاده میpivot pointمتقارن از نقطه محوری شیء )

 

Object Y: 

 کند.ایجاد می Yحالت تقارن بخش انتخابی در راستای محور 

 faceانتخاب  متقارن آن نیز انتخاب خواهد شد. جهت Y ،faceروی مکعبی انتخاب شود، در راستای محور  Faceمثال: اگر یک 

 کند.( استفاده میpivot pointمتقارن از نقطه محوری شیء )

 

Object Z: 

 کند.ایجاد می Zراستای محور  حالت تقارن بخش انتخابی در

 faceانتخاب  متقارن آن نیز انتخاب خواهد شد. جهت Z ،faceروی مکعبی انتخاب شود، در راستای محور  Faceمثال: اگر یک 

 کند.( استفاده میpivot pointمتقارن از نقطه محوری شیء )



 

World X: 

 کند.ایجاد می Xحالت تقارن بخش انتخابی در راستای محور 

 faceانتخاب  متقارن آن نیز انتخاب خواهد شد. جهت X ،faceروی مکعبی انتخاب شود، در راستای محور  Faceمثال: اگر یک 

 کند.( استفاده میpivot point) جهانمتقارن از نقطه محوری 

 

World Y: 

 کند.ایجاد می Yحالت تقارن بخش انتخابی در راستای محور 

 faceانتخاب  متقارن آن نیز انتخاب خواهد شد. جهت Y ،faceروی مکعبی انتخاب شود، در راستای محور  Faceمثال: اگر یک 

 کند.( استفاده میpivot pointمتقارن از نقطه محوری جهان )



 

World Z: 

 کند.ایجاد می Zحالت تقارن بخش انتخابی در راستای محور 

 faceانتخاب  متقارن آن نیز انتخاب خواهد شد. جهت Z ،faceبی انتخاب شود، در راستای محور روی مکع Faceمثال: اگر یک 

 کند.( استفاده میpivot pointمتقارن از نقطه محوری جهان )

 

 

Topology: 

اطراف  هایالی ی ازکیفعال و در نهایت،  topologyانتخاب نموده؛ سپس گزینه  faceابتدا یک جهت استفاده از این گزینه، 

Face خط تقارن یال، نیا نمایید.انتخاب  را (symmetry) یال،  نیادیگر کند و در طرف یم میرا تنظface قارن ایجاد مت

 شود.می

 .داشته باشد Faceتعداد یکسانی  ،برای استفاده از تقارن توپولوژیک روی یک مش، باید در هر نیمه



 

World space  : 

مختصات کل صحنه  ، سیستمworld spaceشود. می نامیدهspaces ، در سیستم مختصاتتغییرات سه بعدی ها و موقعیت

 .دهدفضای جهان را نشان می هایمحور صفحه گرید، .آن در مرکز صحنه قرار دارد منشأ .است

Object space  : 

چرخانده  جسم است و محورهای آن با جسم( pivot)در نقطه محوری  آن مبدأاست.  (object) سیستم مختصات از دیدگاه شی

 شوند.می

Local space  : 

 کند. اینه میاستفاد ءدر سلسله مراتب اشیا ءاست، با این حال از مبدأ و محور گره اصلی شی Objectشبیه فضای  این فضا،

 نجام شده است.یرات روی آن اتغیبخشی از یک گروه است که  شیء،اید، اما شیء را تغییر نداده کهمفید است  گزینه زمانی

 : Pivot Point نقطه محوری

به طور  کند.دهند را تعیین می، حول آن چرخیده یا تغییر مقیاس میآن (component) یا اجزای (object) اشیاءکه ای نقطه

 حولگر می خواهید در مرکز آن قرار دارد. ا ها،آن اجزاییا گروهی از یا گروهی از اشیاء  ءفرض، نقطه محوری یک شیپیش

 . یدنمایتنظیم را  Pivotنقطه باید  چرخد(میاز آرنج  که مانند ساعد) ، چرخش داشته باشید،یک نقطه خاص

Transformation  Relationship to Pivot  

Move  .)هده مشا در شکل زیر، نقطه ی محوری را حرکت می دهد )و شیء همراه با آن حرکت می کند

مت چپ صحنه منتقل به س Pivotپس از حرکت شیء، نقطه  Moveکنید که توسط ابزار می

 شد.

 
 



Transformation  Relationship to Pivot  

Scale  

 
ین ایا از خارج به سمت  ) شکل سمت چپ( تغییر اندازه شیء از نقطه محوری به سمت خارج

 شود.انجام می ) شکل سمت راست( نقطه

Rotation  

 
 ، شیء چرخش دارد.نقطه محوری حول

 :Pivotجهت تغییر نقطه 

 انتخاب شیء یا اجزای آن. .1

 (.Scaleیا  Move ،Rotate) Transformانتخاب یکی از ابزارهای  .2

 از یکی از دو روش زیر: Pivotتغییر مکان نقطه  .3

  فشردن کلیدD  یاInsrt .از کیبورد 

  کلیک روی گزینهEdit Pivot  در بخشTool Settings. 

Icons History  : 

های توسط آبجکت ،ت ورودیلابا اتصا هایآبجکتکند. های مختلف کمک میما در کنترل آبجکته شب ،روه در نوار وضعیتن گای

ثیر أهای دیگر را تحت تآبجکت ی،ت خروجلاهای با اتصاکه آبجکتی، در حالشوندمیگیرند یا کنترل ثیر قرار میأدیگر تحت ت

 کنند. ییا کنترل م دهندمی قرار

 
 پردازیم:های این ابزار میدر ادامه به بررسی گزینه

 Inputs to the selected object  : 

دیگر  یآبجکت ثیرأکه آن آبجکت تحت توریطبه  شودمیاستفاده  ،شده انتخابورودی به آبجکت  تلاتمام اتصا شویرای جهت

 گیرد. یقرار م

 Outputs from the selected object  : 

 . شودمییک آبجکت استفاده  یعملیات خروج شو ویرای انتخاب جهت

 Construction history on/off  : 

 روی یک آبجکت ییرات به وجود آمدهتغجهت ردیابی ساخت و ساز  . تاریخچهرودمیثبت تاریخچه ساخت و ساز به کار  جهت

 . شودمیاستفاده در مراحل بعد 



 : Render Tools Group 

کلیدهای  بررسی. در ادامه به شودمیهای رندر در مایا استفاده کنندهتمام کنترل به یوضعیت برای دسترس نواراین گروه از 

 .  پردازیممی هاین گرو

 

 Open Render View  : 

 . شودمیاستفاده  Render Viewباز کردن پنجره  جهت

 Render the current frame  : 

وضعیت  نوار. از رودبه کار می Maya Softwareاز موتور رندر  استفادهبا  یشده در کادر فعل انتخاب viewportرندر کردن  جهت

در شده رن شنمای ،شود. این پنجرهداده می شنمای Render Viewکنید؛ پنجره  انتخابرا  Render the current frame کلید

 ردن صحنهرندر ک برایده ام شتمام محاسبات انج Output Windowدهد، در همین حین پنجره یرا نشان م یانتخاب حنهصاز 

 دهد. فعال را نشان می

 
  

 IPR render the current frame  : 

معنای  به Interactive Photorealistic Renderingوف اختصاری عبارت رح ،IPR. شودمیانجام  IPR انجام یک رندر جهت

 و به روز رسانی نمایید. مها را تنظیهای نور یا سایه attributeکند تا می کما کماست. این ابزار به ش یتعامل یرندر تصاویر واقع

اخل پنجره د ل. حاشودباز  Render Viewکنید تا پنجره  انتخابرا از نوار وضعیت  کلید این، یندر کردن کادر فعلر جهت

Render View تا یک قسمت را برای رندر  درگ نماییدو  شتهکلید چپ ماوس را نگه داIPR رت دیگر این به عبا. کنید انتخاب

های  attribute، در Attribute Editor، اگر از قسمت لویا ببینید. حاخود را به صورت پ صحنهکند قابلیت به شما کمک می

 شود. شده دوباره بصورت خودکار رندر می تخابانرنگ یا نور صحنه تغییری ایجاد کنید، قسمت 



 Display render setting window  : 

مام شود. این پنجره شامل تداده می شنمای Render  Settings، پنجرهDisplay render setting window کلید انتخاببا 

های فایل، کیفیت ری تریس مواردی مثل کیفیت، گزینه مشما در تنظی بهها کنترل اینمورد نیاز برای رندر است.  هایکنترل

 کند. یره کمک میغو 

  
 



 Display hypershade window  : 

 ایجاد کنید.  shadingهای توانید شبکهبا استفاده از این پنجره می. شودمیباز  Hypershadeاین کلید، پنجره   انتخاببا 

 
 

 Launch Render Setup Window  : 

 راست سمتدر ق Property Editorدر قسمت چپ و  Render Setupبا  Render Setup Editor، پنجره کلیداین  انتخاببا 

، Layer نجرهپو  ها collection و  ها override، ها  Property Editorایجادامکان  Render Setup. پنجره شودمیداده  شنمای

 دهد. یشما م بها را هآن بهمقادیر مربوط  مامکان تنظی  و

 



 Open the Light Editor : 

همراه با ، حنهص. این پنجره تمام نورهای داخل شودمی نااینم Light Editor (Global Mode)، پنجره کلیداین   انتخاببا 

attribute  کندمیهای استفاده شده برای هر نور را لیست . 

 

 Toggle pausing Viewport 2 display update  : 

ات و افزودن عناصر قفل شده و از تغییر viewportبه نوعی کاربرد دارد.  viewport 2  شنمای رسانیروز ه این کلید برای توقف ب

 نشانه فعال بودن این دکمه است. viewportکادر قرمز دور  کند.جدید جلوگیری می

 



  Select field: 

های ایجاد شده در صحنه را ، تغییر نام و ایجاد تغییرات برای آبجکتابانتخکند تا وضعیت به شما کمک می نواراین گروه از 

گزینه پ که سمت چ یا، روی فلشهآن شان هستند. برای نمایهی این گروه در حالت پنهاگزینهاز  ی. بعضدهیدبا سرعت انجام 

input line of operation  گزینه  ل. حاشودمی ناایکادر معلق نم یکرا نگاه دارید؛  ماوسدارد کلیک کرده و کلید  قرار

 .شودکنید تا حالت مورد نظر نشان داده  انتخابواه خود را دلخ

 
 . شودمی بررسی transformهای مختلف فعال است. در ادامه حالت Absolute Transformفرض، حالت شبه صورت پی 

 
 : Absolut Transform 

د نظر را از مور transformationکار، ابزار  این برایاست.  viewportدر  یانتخابیا تغییر اندازه آبجکت  شحرکت، چرخ جهت

کلید  پسنمایید. سمقادیری وارد  Absolut Transform کادرداخل  Zو  X ،Y شکنید و در کادر ویرای انتخاب ابزارجعبه 

ENTER  دهد. یچرخد و تغییر اندازه مبا توجه به مقادیر وارد شده جابجا شده، می یانتخابرا فشار دهید؛ آبجکت 

 : نکته 

 کند. می انتخابرا به عنوان مرجع برای تغییرات آبجکت  viewportمرکز  ،Absolut Transformفضای 

  
 : Relative Transform 

 Absolut زینهگشبیه  گزینه،. این شوداستفاده می viewportده در ش انتخابآبجکت  یو جابجای شچرخ ،تغییر اندازه جهت

Transform  گزینه کهاست با این تفاوت Relative Transformییرات آن ، محل قرارگیری آبجکت را به عنوان مرجع برای تغ

 کند. می انتخاب

 
 : Rename 

 م؛ اسکنید انتخاب viewportجکت، آن را از . برای تغییر دادن نام یک آبشودمیاستفاده  ،دهش انتخاب آبجکتتغییر نام  جهت

کادر وارد  در آن آبجکتبرای . یک نام جدید شودمیان داده نش Renameی تن فضاشده در کادر م انتخابت فرض آبجکپیش

 را فشار دهید.  ENTERکنید و کلید 

 : Select by name 

 کنید.  انتخابآن را  ،Select by nameدر کادر متن  آبجکت یکتوانید با وارد کردن نام شما می

  



 
  IPM Button: 

 شامل سه گزینه است:  کهوجود دارد  یدر این گروه یک لیست کشوی

Sign In ،Explore Purchase Options  وManage License. 

 
Sign In: 

 .شوداستفاده می Autodeskکاربری  بورود به حسا جهت 

 
 

Explore Purchase Options: 

ت مختلف لاتوان از آن محصومیشده و باز  Autodesk Storeاینترنتی سایت ، صفحه یلیست کشوی این گزینه از انتخاببا 

 . نمودرا خریداری  Autodeskشرکت 

 
 



Manage License: 

 . نمودتوان از آن مجوز نرم افزار را مدیریت کند که میرا باز می License Managerصفحه 

 
 

 :  ها Panel کلیدهایگروه 

 
و  Modeling Toolkit ،Character Controls ،Attribute Editor ،Tool Settingفرض کلید پیش ۵این بخش حاوی 

Channel Box باشد.می 

Show/Hide Modeling Toolkit  : 

 سازیمدل مختلفعملیات  حاوی Modeling Toolkit. پنجره شودمیاستفاده  Modeling Toolkitردن پنجره باز ک جهت

  است.



 
 

Show/Hide The Character Control Tool : 

 . شودمیاستفاده برای تنظیمات مختلف کاراکتر  Human IKپنجره  ردناز کب جهت



 
 

Show/Hide the Attribute Editor  : 

مختلف  propertiesکنترل  برای Attribute Editor از پنجره. شودمی استفاده Attribute Editor شعیت نمایر وضتغیی جهت

 شده است.  انتخابآبجکت 

 
 



Show/Hide the Tool Settings  : 

 انتخابرا از جعبه ابزار  Moveبرای مثال، اگر ابزار . شودنمایش داده می Tool Settingsشده، در پنجره  انتخابهای ابزار گزینه

 ، کنترل کنید. Tool Settings (Move Tool)پنجره توانید تنظیمات آن را با استفاده از کرده باشید، می

  

 Show/Hide The Channel Box  : 

 Channel Box / Layer کلیدد مانن کلیدکاربرد دارد. این Show/Hide The Channel Box ش نمای وضعیت تغییر جهت

Editor   .استChannel Box ربرد اود. کشیم استفادهده ش انتخابآبجکت  یبرای کنترل متغیرها و ساختار هندسLayer 

Editorدر  آبجکتها در صحنه در مواردی که تعداد زیادی دیریت آبجکت، مviewport ای هتوان آبجکتت. میوجود دارد، اس

 مرتب کرد.  صحنهسازی برای ساده layer editorریق ط چندگانه را از

 : نکته 

برای اضافه . شودمیداده  شنمای Channel Boxشده در  انتخابهای آبجکت میل تنظهای قاب attribute، فرضشبه صورت پی

  ابانتخرا Channel Control < General Editors < Editors < Windows های بیشتر، از نوار منو دستور  attributeکردن 

 Nonkeyable: کنیدیم مشاهده Keyableپنجره، سه فضا در زبانه  این. در شودمینشان داده  Channel Controlره پنج ؛کنید

Hidden ،Keyable  وNonkeyable  .Displayed  برای اضافه کردنattribute ا را از قسمت هها، آنNonkeyable Hidden 

 را بزنید.  Closeکلیک کنید و بعد کلید  Move  <<د پس روی کلیرده و سک انتخاب

  
 



 

 
 



 

1-4-3/2 Shelf Area )ناحیه قفسه( 

و قسمت پایین  shelfف ی مختلهازبانه ،لا. قسمت باشودمی ممت تقسیه دو قسب Shelf. رار داردوضعیت ق نوار پایین این نوار،

 یبستگ است، شده انتخابه کای داده شده در این قسمت به زبانه شهای نمایآیکون. شودمیمل مختلف را شا هایآیکون ابزار

 دارند. 

 
، Menu of items to modify the shelfکار روی کلید  نبرای ای نمایید.سازی یرا شخص Shelf ،به نسبت نیاز خود توانیدمی

 .  مپردازییست مف این لیی مختلهاگزینه یدر ادامه به بررس. شودمیکلیک کرده و نگه دارید. یک لیست معلق نشان داده 

 
 : Shelf Tabs 

و فقط آیکون  دهشناپدید  Shelfهای این گزینه، زبانه انتخاب. با شودمیاستفاده  shelfهای تغییر وضعیت نمای زبانه جهت

 قابل مشاهده است.  ی،انتخابهای هابزارهای مربوط به زبان

 
 : Shelf Editor 

در  Shelf Editor کنید انتخاباین گزینه را  ی. وقتشودمیموجود استفاده  shelf تنظیماتبرای و  shelfایجاد یک  جهت

 . شودمیداده   شنمای viewportصفحه 

را  Shelf Editorز نی Windows > Settings/Preferences > Shelf Editor منو با دستور نواراز  توانیدمیاز  سوی دیگر شما  

با استفاده از  توانیدمیین همچنا را تغییر دهید. هها و محتویات آن shelfنام و موقعیت  توانیدمی، Shelf Editorباز کنید. در 

Shelf Editor  یکshelf  .جدید و محتویات آن را ایجاد کنید 



 
 

 : Navigate Shelves 

گزینه یک منوی ن ای انتخاب. با شودمیاستفاده  ،شده انتخاب shelfقبل یا بعد  shelf  انتخاب، برای Navigate Shelvesگزینه 

   کنیم.ی میهای موجود در این منو را بررسگزینه. در ادامه شودمیباز آبشاری، 

  
 

: Previous Shelf 

کنید؛  انتخابرا  Renderingنه ل، زبا. برای مثاشودمیتفاده قرار دارد اس یاز شلف فعل  شکه پی یشلف انتخاباین گزینه برای 

کلیک کرده و نگه  Menu of items to modify the shelf. سپس روی گزینه شوندمیداده  شه آن نمایوط بهای مربآیکون



 Previous، دهشاز اری ببرده و از منوی آبش Navigate Shelves هانگر ماوس را روی گزین. نششودمیدارید؛ لیست معلق باز 

Shelf  کنید. زبانه  انتخابراAnimation  شودمیی مربوط به آن نشان داده هاو آیکون انتخابرا . 

 : Next Shelf 

 شده است.  انتخاب shelfبعدی  shelf  انتخاببرای  Next Shelfگزینه 

 : Jump to Shelf 

گزینه، کادر  نای انتخاب. با شودمیاستفاده  آن خاص، با وارد کردن نام shelfبرای باز کردن یک  Jump to Shelf گزینه

کنید؛  نتخابارا  OKوارد و کلید  Shelf Name یتنورد نظر را در کادر مم shelf. نام شودمیباز  Jump to Shelfگفتگوی 

 . شوندمیداده  شای مربوط به آن نمایهراه آیکونمورد نظر به هم shelfزبانه 

 
 

 : New Shelf 

ینه، کادر گفتگوی گزن ای انتخاب ا. بشودمیهای موجود، استفاده shelfجدید به  shelfزبانه  افزودنبرای  New Shelfگزینه 

Create New Shelf  یک نام برای شودمیباز .shelf  جدید وارد کنید و کلیدOK  را بزنید؛ یکshelf  ،شودمیخته اسجدید .

ی دلخواه را از را نگه دارید و ابزارها CTRL+SHIFTکلید های  ساخته شده، shelfرای اضافه کردن ابزار به قسمت ابزارهای ب

 کنید.  انتخاب یمنوهای کشوی

 
  

 :کنید عمل صورت بدین جدید، shelf به منوها از دلخواه ابزار یا دستور  ردن یکجهت اضافه ک

Shift + Ctrl   دستور انتخاببه همراه 

 
 

 : Delete Shelf 

کلیک  OK. روی کلید شودمیباز  Confirmاین گزینه، کادر پیام  انتخاب . باشودمیاستفاده  shelfاین گزینه برای حذف یک 

 شده حذف شود.  انتخاب shelfکنید تا 

  



 

 : Load Shelf 

کنید، می نتخابارا  Optionاین  ی. وقتشودمیاند استفاده ساخته شده که قبلاً  یهای shelfبرای آوردن  Load Shelfگزینه 

  انتخاب shelf کنید. زبانه ابانتخیره شده را از آن خذ قبلاً ای که  shelf توانیدمیشما . شودمیز با Load Shelfکادر گفتگوی 

 . شودمیداده  شنمای shelfشده در قسمت 

 

 



 
 

 : Save all Shelves 

 ا استفاده کنید. هآن هنگام کار با مایا از رود تا بتوانید بعداًیه کار مها ب shelfبرای ذخیره کردن  Save all Shelvesگزینه 
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ایا دارند. علاوه بر متفاده را در است که بیشترین اس یرار گرفته و شامل ابزارهایق فزاراجعبه ابزار در سمت چپ محیط کار نرم

 کند.مک میکبندی فضای کار برنامه  طرحما در تغییر ت که به شاس یها و دستورات مختلفاین، جعبه ابزار شامل گزینه
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ن ها در انیمیشملغزنده، برای کنترل فری نوارقرار دارد. این دو  viewport، در پایین  Time Slider and Range Sliderقسمت 

   Time Slider. یک کادر ورودی در گیردمیبر  ده در انیمیشن را درتفاده شهای اسمفری Time Slider نوار. شوندمیاستفاده 

با خط  Time Sliderدهد. کلیدهای داخل یانیمیشن را نشان م یفعل موجود دارد که فریSet the Current time Slider  به نام

 . شوندمیهای قرمز نشان داده 

 
با نام  ، مستطیل خاکستری کهTime Sliderدهد. در یهای موجود در انیمیشن را نشان مممحدوده فری Time Slider نوار

scrub bar  رد دارد. کلیدهای رای انیمیشن کاربود بی موجهامفعال فریبرای حرکت به جلو و عقب در محدوده  شودمیشناخته

Playback اعلیه راست قسمت هدر منتcurrent frame به شما در ،play  وstop کنندن کمک میکردن انیمیش .Range Slider 

 .شودمیانیمیشن استفاده  playbackمحدوده  تنظیمقرار گرفته برای  Time Sliderکه پایین 

Range Slider دهد.  یانیمیشن فعال را نشان م ناایزمان شروع و پ 

 یده راهنمایش انتخابمحدوده  یایهو انت یابتدای مشما را به فری ،دو هر Range Sliderسمت چپ و راست  شکادرهای ویرای 

 Set the end timeورودی، قابل تغییر است. سمت راست کادر شبا استفاده از کادرهای ویرای Range Slider طولکنند. می

of the animation کلید ،layer Set the active animation زم برای ساخت لاهای قرار دارد. با این قابلیت شما به تمام گزینه

ک صحنه ترکیب یکند چندین انیمیشن را در یکنید. این گزینه به شما کمک میپیدا م یهای انیمیشن دسترسلایهو مدیریت 

کتر ارقرار دارد که برای کنترل خودکار رپر کا Set the current character set، قسمت Range Sliderراست  کنید. سمت

 Animation preferences :دارد قرار Range Slider مت راسته ساعلیه. دو کلید در منتشودمیسازی شده استفاده متحرک

 .شوندمی یاین کلیدها در ادامه بررس.  Auto keyframe toggle و

 :نکته  

از  شیما پا. ن کلید بزنیدورد، برای انیمیشروی کیب Sد یا کلیkey >  Set Key   انتخابمنو با  نواراز  توانیدمیشما همچنین 

 اید.هکرد انتخابرا  Animation منوستآن مطمئن شوید که 



 : Auto keyframe toggle   

سازی چیزی . این کلید هرگاه که هنگام متحرکشودمیاستفاده  keyframeبرای قرار دادن  Auto keyframe toggleد کلی

 کند. تغییر می قرمزه گ آن برن ،بودن کلیدسازد. در صورت فعالیم keyframeتغییر کند به صورت خودکار یک 
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 Python scriptیا  MEL scriptدر محیط مایا با  شاین بخست. ه اقرار گرفت Time Sliderپایین  Command Lineقسمت 

را  Melکلید  ،ینویسبین دو زبان برنامه یدر مایا هستند، برای جابجای ینویسهای برنامهزبان Pythonو  MEL. کندکار می

  است( قرار گرفته Help نوار بالایاین کلید ) کنید. انتخاب

 
ست علیه سمت را اهدهد. در منتیخاکستری سمت راست، نشان م درر کاهای برنامه را دهمچنین پیام Command نوار

Command Line  یک کلید برایScript Editor قرار دارد .Script Editor  برای اعمال دستورات پیچیدهMEL  وPython  در

 . شودمیصحنه استفاده 

  : نکته 

MEL عبارت  حروف اختصاریMaya Embedded Language  است. دستورMEL ت که برای اس یهای متنیک گروه از رشته

 . شودمیاجرای عملکردهای مختلف در مایا استفاده 
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یط مایا را به فعال در مح  ششده و یا بخ انتخابقرار گرفته و توضیحات مختصری درباره ابزار  Command Line پایین Help Line نوار

 .دهدیشما ارائه م
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viewport : 

  .شوندمیشناخته  viewportعنوان نما یا  به در آن یک صحنه سه بعدی ایجاد کنید توانیدمیکه ای پنجره

 شود.میداده  نمایشفرض شپیبه صورت پکتیو پرسبوده که نمای ( viewportمایا دارای چهار نما )



 
 

Grid: 

 سه هایآبجکتتنظیم ود دارد. از صفحه گرید به عنوان یک مرجع برای وج gridدر مرکز هر نما یک صفحه مشبک به نام 

د جاای ار مربع یهاه فرمت کع اسطوط موازی و متقاده از خط؛ صفحه گرید تشکیل ششودمیبعدی یا خطوط دو بعدی استفاده 

 اند. ردهک

 : مبدأ نقطه

مبدأ یک  طهگویند. نق مبدأع این دو خط را طنقطه محل تقا حاصل شده است.تر تیره با رنگ عاطدو خط متق ازمرکز گرید 

  تنظیم صفر مبدأ روی موقعیت در نقطه Zو  X ،Yاست. هر سه مختصات  هاآبجکتقراردادی برای تعیین موقعیت  نقطه

 . اندشده

 نکته: 
 . مشخص شده استی های قرمز، سبز و آببا رنگبه ترتیب  Z  و X ،Y محورهای تهدر مایا ج

 نماهای مایا:

 (هاآبجکتدو بعدی از  تصویر)نمایش  اورتوگرافیک 

o لابا- top  در راستای محور(Y) 

o روبرو- front  در راستای محور(Z) 

o لوهپ- side  در راستای محور(X) 

 (هاآبجکتبعدی از  سهتصویر )نمایش  ایزومتریک 

o پرسپکتیو 

  .باشدیمربوط به آن نما م یبه ابزارها یمختص به خود، جهت دسترس Panel یمنو یهر نما دارا



  .دهدیرا نشان م Z و X ،Y یهر نما، جهت محورها نیینشانگر محور مختصات واقع در گوشه سمت چپ پا  :  

 نیده است. نام دوربقابل مشاه شیآن صفحه نما قیشده که از طر هیتعب فرضشیبه صورت پ ینی: در هر نما، دورب  

 داده شده است. شیهر نما نما نیی)نام نما(، پا

  : نکته 

 ، از یکی از دو روش زیر اقدام نمایید:ار نماهبرای تغییر وضعیت از تک نما به چ

 از نماها برده و کلید  ینشانگر ماوس را روی یکSpace  .روی کیبورد را فشار دهید 

  در نوار سمت چپ  روی کلیدviewport .کلیک نمایید 

 
 : Panel منوینوار 

 فضای در شده اجرا هایفعالیت تمام ، Panel  منوینوار  در موجود هایگزینه و دستورها .است موجود ها viewport همه در

 .شد خواهند یبررس ادامه در که باشدمی منو شش ملشا Panel menu .کندیم کنترل را کار



 
 

 : View 

 های مختلف است. های مختلف با دوربین، از زاویهviewportآبجکت در  شبرای نمای Viewکاربرد منوی 

  

 : Shading 

 X-Ray ،Flat Shade All ،Smooth Shade All ،Wireframeف مثل های مختلآبجکت در حالت  شبرای نمای Shadingمنوی 

  Wireframe On Shaded modeتدر حال یدر این منو، به راحت   Shadedبا استفاده از گزینه توانیدمیاست. همچنین  غیرهو 

 .کار کنید

 : Lighting 

 viewportموجود در  یهاآبجکت یتعیین شده روشنایشند تا با استفاده از نورهای از پیکیبه شما کمک م Lightingمنوی 

 کنید.  تنظیمرا 

 : Show 

 . شودمیموجود در صحنه استفاده  یهاآبجکتکردن یک گروه مشخص از یا آشکار ان هبرای پن Showمنوی 

 : Renderer 

و  یچرهای رنگت تکسکیفی توانیدمی. همچنین شودمیاستفاده  viewportکیفیت رندر در  تنظیمبرای  Rendererمنوی 

 کنید.  تنظیمهای این منو  را با استفاده از قابلیتلابرای رندرهای با کیفیت با bumpتکسچرهای 

 : Panels 

 . شودمیدیگر استفاده  viewportفعال با یک  viewportبین  یبرای جابجای Panelsمنوی 
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 .دارد ودوج ها viewport همه Panel منوی پایین ، Panel زاراب نوار

 .یمپردازیم ابزارها این یبررس هب ادامه در ست.ا Panel منوی در موجود استفاده رپ ابزارهای اکثر شامل ابزار نوار این



 

 
 Select Camera : 

 صحنه در فعل دوربین توانیدمی همچنین شما .شودمی استفاده viewport در فعال دوربین انتخاب رایب Select Camera ابزار

 روی لفختم دوربینهای دید زاویهبین  ییجابجا برای .کنید انتخاب Panel منوی از View > Select Camera از استفاده با را

 دوربین به مربوط، ینهزگ انتخاب با توانیدمی لاحا .شودمی ظاهر میانبر، منوی یک کنید؛ کلیک راستSelect Camera  ابزار

 .کنید سوییچ خود رنظ مورد

 
 



  Lock Camera : 

 یدتوانمین ماش باشد قفل دوربین یوقت .شودمی ستفادها  viewportدر لافع یندورب کردن قفل برای Lock Camera ابزار

properties  ابزار رهدوبا دوربین قفل کردن باز اید. بردهی تغییر را آن شچرخ و یجابجای مانند یهای Lock Camera انتخاب را 

 .نیدک

 Camera Attributes  : 

 در که شودمی استفاده Attribute Editor شبخ در فعال، دوربین های attribute دادن اننش رایب Camera Attributes زاراب

 این Panel ویمن در View > Camera Attribute Editor مسیر از توانیدمی همچنین .گیردمی قرار viewport راست سمت

attribute دهید شنمای را ها. 

  Bookmarks : 

 تنظیم viewport در نما یک توانیدمی شما گذاری،نشانه برای .شودمی استفادهی فعل نمای گذاریهنشان ایرب Bookmarks ابزار

 ینهمچن ماش .شودمی ذاریگنشانه آینده موارد در استفاده برای شده تنظیم نمای کنید؛ انتخاب را Bookmarks ابزار و دکنی

 یک دارید؛نگه و کرده راست کلیک Bookmarks ابزار روی کار، این برای .کنید شویرای را موجود های Bookmark توانیدمی

 Edit 2D گزینه ،منو این از .شودمی داده شنمای Panel ابزار نوار در شده، ایجاد های bookmark از یتلیس با میانبر منوی

Bookmarks  کنید انتخاب را. 

 
 هانام توانیدمی شما .شودمی ظاهر ،شده داده نشان 1 - 55 تصویر در که ، Bookmark Editor (prsp)گفتگوی کادر ،کار این با 

 .دهید تغییر پنجره این در را هانشان های attribute دیگر و

 

  Image Plane  : 

ه پنجر ، Image Planeابزار انتخاب با .شودمی استفاده ،فعال  viewportبه تصویر یک کردن وارد برای Image Plane ابزار

 انتخاب تصویر کنید؛ خابانت را کنید وارد viewport به خواهیدمی که تصویری فایل ،پنجره این در .شودمی باز Open گفتگوی

 View > Image Plane > Import Image مسیر از را نظرتان مورد تصویر توانیدمی همچنین .گیردمی قرار viewport در شده

 .کنید وارد ، Panelیمنو از



 2D Pan/Zoom  : 

  .شودمی استفاده 2D Pan/Zoom حالت کردنفعال و غیر فعال برای 2D Pan/Zoom ابزار

 Grease Pencil : 

  Grease Pencil پنجره ،ابزار این انتخاب با .شودمی استفاده viewport در بعدی دو هایاسکچ طراحی برای Grease Pencil ابزار

 View > Camera Tools > Grease مسیر از را ابزار این توانیدمی همچنین .شودمی ظاهر، شده داده نشان 1 - 56 تصویر در که

Pencil Tool پنجره  منوینوار  ازviewport  کنید انتخاب.  

 

  Add Frame جهت ایجاد فریم روی :Time line رود.برای ترسیم طرح به کار می 

 رود.به کار می Time Line: فریم ایجاد شده روی  

  Remove Frameرود.: جهت حذف فریم انتخابی به کار می 

 Pencil ابزار :Pencil رود.جهت طراحی به کار می 

 Marker ابزار :Marker رود.جهت طراحی به کار می 

  : Soft pen  ابزارSoft Pen رود.جهت طراحی به کار می 

 



Ghost:  های ترسیم شده توسط ای( از تمام طرح)شبح یا هالهGrease Pencilدهد.می، فریم قبل و بعد آن طرح را نمایش 

تا تصاویر را  توانید چگونگی نمایش تصاویر شبح را تنظیم نمودهکنید، میهای مداد گریس کار میای از فریمزمانی که با دنباله

 کند.در برنامه عمل می onion skinاین گزینه، مشابه  .با هم ترکیب کنید

  Change Color.با دابل کلیک روی این نوار قرمز رنگ، پانل رنگ باز شده تا رنگ قلم را انتخاب نمایید : 

 

 Eraserرود.: جهت حذف تمام یا بخشی از طرح ترسیم شده به کار می 

 Show Pre-Frame ghostsهای قبلی فریم جاری را زمان پخش انیمیشن توان طرح درون فریم: توسط این دکمه می

 نمود.مشاهده 

 Show Post-Frame ghostsهای بعدی فریم جاری را زمان پخش انیمیشن توان طرح درون فریم: توسط این دکمه می

 مشاهده نمود.

 های نکته: توسط کلیک راست روی دکمهghostهای قبل و بعد فریم جاری را جهت توان تعداد فریم، از منوی باز شده می

 توان تعیین نمود.فریم می 10نمایش تعیین نمود. حداکثر 

  

 Import Grease frame جهت :Import رود.)وارد نمودن( طرح آماده به برنامه مایا به کار می 

 Export Grease Frame جهت :Export رود.)ارسال( طرح و ذخیره در یک فایل به کار می 



 Help جهت مراجعه به سایت :Autodesk  مورد ابزار  برای دریافت راهنمایی درGrease Pencil رود.به کار می 

 
 

کند. برای کار با این ابزار، ابتدا فریمی را انتخاب نموده این ابزار جهت طراحی مسیر حرکت شیء در طول انیمیشن کمک می

بسته به د طرحی در صحنه رسم نمایید. سپس در چند فریم بع soft penو  pencil ،markerو توسط یکی از سه ابزار طراحی 

نیمیشن قرار سرعت انیمیشن، مجدد همان طرح را در مکان جدید طراحی نمایید )مکان جدید: جایی است که کاراکتر اصلی ا

ا اجرای انیمیشن است در آن قرار گیرد(. به همین ترتیب فریم دیگری انتخاب و مجدد طرح را در مکان دیگری رسم نمایید. ب

حی شد میشن به چه صورت قرار است در صحنه حرکت نماید. حال که مسیر حرکت طراخواهید دید که کاراکتر اصلی انی

 ده را کشیده بودیم قرار دهید. هایی که طرح ساها مراجعه کرده و این بار کاراکتر اصلی را در مکانتوانید مجدد به همان فریممی

 
 

 



 Grid  : 

 Show مسیر از توانیدمی همچنین را ابزار این .شودمی تفادهسا  viewportدر grid صفحه شنمای وضعیت تغییر برای Grid ابزار

> Grid منوی از Panel کنید انتخاب. 

 
 منوی در grid ابزار روی ر،کا این برای. کنید تنظیمviewport  در را grid های attribute ابزار این با توانیدمی این، بر لاوهع 

panel هگزین .شودمی ظاهرق معل منوی یک .دارید نگه و کرده کلیک راست Grid Option د.کنی انتخاب منو از را 

 
 grid های attribute توانیدمی شما سپس .شودمی ظاهر شده داده نشان 1 – 57 تصویر در که Grid Options گفتگوی کادر 

 .کنید تنظیم نیاز مطابق را

 
 Film Gate : 

  همچنین شما .شودمی استفاده فعال، viewport در Film Gate شنمای حالت غیر فعال کردنفعال یا  برای Film Gate ابزار

 استفادهviewport  در Film Gate شنمای رایب Panel منوی از View > Camera Settings > Film Gate مسیر از توانیدمی

 .کنید



 
 

 Resolution Gate : 

ی فضای ،کادر . اینشودمی استفاده viewport در Resolution Gate کادر فعال کردنفعال و غیر  برای Resolution Gate ابزار

 < View > Camera Settings مسیر از توانیدمی همچنین .کندمی مشخص را شودمی داده نشان رندر در که viewport از

Resolution Gate منوی از Panel کنید استفاده کادر این تنظیم برای. 



 
 

Gate Mask  : 

 یا Film Gate دور که یفضای حوضو میزان و رنگ ابزار این .شودیم استفاده Gate Mask مرز شنمای برای Gate Mask ابزار

Resolution Gate  دهدیم تغییر را گرفته قرار. 

Gate Mask  شما هک کندمی کار یزمان اهتن Film Gate یا و Resolution Gate  به ار viewport ماش .باشید کرده اعمال 

 .کنید انتخاب را ابزار این نیز Panel منوی از View > Camera Settings > Gate Mask مسیر از توانیدمی

Gate Mask  به همراه Film Gate: 



 
 

Gate mask   به همراهResolution Gate: 



 
 
 

 Field Chart : 

  ظاهر ایبکهش صفحه یک ، Field Chartابزار انتخاب با .شودمی استفاده field chart کادر شنمای برای Field Chart ابزار

 که شود استفاده ایدب یزمان اهتنField Chart ابزار .است cell animation زمینه استاندارد اندازه دوازده دهنده انشن هک شودمی

 View > Camera Settings > Field مسیر از توانیدمی همچنین را ابزار این .باشد شده تنظیم NTSC ابعاد روی رندر کیفیت

Chart منوی از Panel کنید اجرا. 

 



 Safe Action : 

 در مینانطا محدوده تنظیم برای ابزار این کاربرد .شودمی استفاده Safe Borders کادر شنمای برای Safe Action ابزار

viewport  ،مسیر از را ابزار این توانیدمی همچنین .است یتلویزیون تولیدات مناسب فعال View > Camera Settings > Safe 

Action منوی از Panel کنید اجرا. 

 Safe Title : 

 viewport در ناطمینا محدوده تنظیم برای همچنین ابزار این از .دارد کاربرد Safe Title کادر شنمای برای Safe Title ابزار

 Panel یمنو از View > Camera Settings > Safe Title مسیر از Safe Title .شودمی استفاده یتلویزیون تولیدات مناسب

 .است یدسترس قابل نیز

 

 

 Wireframe : 

 مسیر از توانیدیم ند. همچنیدار کاربرد)نمایش حالت سیمی(   wireframeنمای کردنفعال و غیر فعال برای Wireframe ابزار

Shading > Wireframe منوی از Panel ، روی 4 دکلی فشردن دیگر، سوی از .کنید استفاده آن نمای عیتوض تغییر برای 

 .کندیم خاموش و روشن را  wireframe نیز کیبورد

 



 Smooth Shade All : 

 Shading > Smooth Shade مسیر از توانیدمی .شودمی استفادهsmooth  حالت نمای تغییر برای Smooth Shade All ابزار

All منوی در Panel حالت توانیم نیز کیبورد 5 کلید از استفاده با همچنین .دهید انجام را کار این نیز Smooth Shade All 

 .کرد خاموش یا روشن را

 

 Use default Material : 

 در که یزمان ،هاآبجکت روی مایا ) که به رنگ خاکستری است( فرضپیش لامتری شنمای برای Use default Material ابزار

 .شودمی استفاده هستند، smooth shaded حالت

 

 Wireframe On Shaded : 

 این توانیدیم همچنین .است smooth shaded یهاآبجکت روی بر wireframe شنمای برای Wireframe On Shaded ابزار

 .کنید انتخاب Panel منوی از Shading > Wireframe On Shaded مسیر از را ابزار

 
: Textured 

 از استفاده با ،دیگر سوی از .شودمی استفاده viewport در هاآبجکت افزاریسخت تکسچر شنمای تنظیم برای Textured ابزار

 .کنید سوییچ افزاریسخت تکسچر شنمای حالات به توانیدمی نیز کیبورد 6 کلید

 



 Use all lights : 

کرده باشید موضوعات ناگر نوری تعریف  .است viewport در موجود نورهای تمام با هاآبجکت به ینورده برای Use all lights ابزار

 .رسندتاریک به نظر می

 
 Panel نواراز  Use All Lightsگزینه  انتخابیا  Lightingاز موی  Use All Lights انتخابدر صورت تعریف چندین نور و 

 Use Allکه گزینه . در صورتی، تأثیر تمام نورها بر آبجکت قابل مشاهده خواهد بود. )تصویر سمت چپ( viewportبخش 

Lights  نواراز Panel  بخشviewport  غیر فعال شود و گزینهUse Default Lighting  را از منویLighting مایید ن انتخاب

 پذیرد. فرض را میشتصویر فقط تأثیر یک نور پی

 
 .دهید نجاما را کار این توانیدمی نیز کیبورد 7 کلید فشردن با یا و Lighting > Use all lights مسیر از همچنین 

 .یک نور ایجاد کنید و مورد بالا را امتحان کنید Lights و بخش ،Create  برای تمرین، از منوی

 :  Ambient Lightایجاد نور  _1تمرین 

 



 
 :  Ambient Lightایجاد نور  _2تمرین 

 
 :  Ambient Lightپس از ایجاد نور  Drectional Lightایجاد دو نور  _ ۳تمرین 

 

 

 :نکته 
نکرده  خابانتنمایید ولی هیچ یک از نورهای درون صفحه را  انتخاب Lightingرا از منوی  Use Selected Lightگزینه اگر 

 باشید، تصویر به رنگ سیاه دیده خواهد شد.

 :نکته 
را توسط کلیک  باز نموده و نورهای دلخواه Windowرا منوی  outlinerنورهای موجود در صحنه بهتر است پنجره  انتخاببرای 

 نمایید. انتخابها، روی آن



 :نکته 
 و حرکت آن به جهات مختلف. moveکردن ابزار ، سپس فعالoutline نور مدنظر از پنجره  انتخاببرای تغییر زاویه تابش نور: 

 

 
 Shadows : 

 یزن Panel منوی از Lighting > Shadows مسیر از همچنین .است افزاریسخت سایه هاینقشه یشانم رایب Shadows زاراب

 حالت در Panel یمنو از Use all lights ابزار که است استفاده قابل زمانی تنها ابزار این .داشت خواهید یدسترس ابزار این به

 .باشد انتخاب

 
 

 Screen space ambient occlusion : 

 نهات ابزار این .است viewport در ambient occlusion یشنما وضعیت تغییر برای Screen space ambient occlusion ابزار

 .باشد فعال Viewport 0.2 که است استفاده قابل زمانی

 realtime ه صورتباین اسکریپت زمانی که بر روی دوربین استفاده شود باعث ایجاد سایه ناشی از نزدیکی دو جسم به یکدیگر 

 .دادن بازی بسیار مؤثر استشود که در زیباتر جلوهمی

 در تصویر اول: سایه مکعب اولی به طور کامل قابل مشاهده است. 

 
 در تصویر دوم:



کنند و کمرنگ و به سفیدی و سایه هر دو مکعب تغییر می دار اولی،دار دوم به مکعب سایهکعب سایههنگام نزدیک شدن م 

 .شوندمینور تبدیل 
 

 
 Motion blur : 

ها در صحنه، آبجکت های()محو لبه کردن، برای شما با بلوری motion blurگیرید، افکت وقتی که یک انیمیشن را رندر می

 .باشد فعال Viewport 0.2 که است استفاده قابل یهنگام تنها زاربا این .کندسازی میشبیهافکت حرکت را 

 

 Multisample anti-aliasing : 

 .شودمی استفاده viewport رد multisample anti-aliasing خود شنمای وضعیت تغییر برای Multisample anti-aliasing ابزار

 .است استفاده قابل دباش فعال Viewport 0.2 که زمانی تنها ابزار این

 های ویدیویی، از تکنیک ضد تر شدن تصاویر در بازیطبیعی و های تصویرلبه« پلکانی» یا «دندانه دار»حالت برای از بین بردن 

anti-aliasing  کند؛ اند، تغییر مید آمدن لبه و تیزی شدههایی که باعث به وجورنگ پیکسل، تکنیکاین در  کنند.استفاده می

شدن ها و برجستهتا تفاوت رنگ شدههای محیط اطراف خود ترکیب های لبه یک شی با رنگ پیکسلبه این معنا که رنگ پیکسل

ها را بررسی کرده و تمام کند، زیرا باید تمام پیکسلاین کار فشار بسیار زیادی به کامپیوتر وارد می ها کمتر به چشم آید.لبه

 شود.می استفاده mssa تکنیکاز  ssaa تکنیک به جای استفادهای اضافی را روی تصویر بیاورد. به همین دلیل، هآن رنگ

supersample anti-aliasing (:) گیردهای یک فریم یا تصویر صورت میدار روی تمام پیکسلهای لبهعمل ترکیب رنگ پیکسل. 

Multisample anti-aliasing (:)  دهد که نیاز است عمل ضد الایزینگ روی آن اعمال رار میقرا مورد هدف بخشی از تصویر

 گیرد.ها را نادیده میشود و بقیه پیکسل

 



 

 Depth of field : 

 Viewport که مانیز تنها ابزار این .شودمی استفاده viewport در میدان عمق شنمای وضعیت تغییر برای Depth of field ابزار

 .است استفاده قابل باشد فعال  0.2

، این افکت باشدمیمات  ،ای از دید دوربین واضح و بقیهشود به طوری که منطقهسازی لنز دوربین میاسکریپت باعث شبیه نای

 .شودیتر شدن دید دوربین مباعث طبیعی

 .شوندمیدر تصویر زیر، گوی آبی به صورت واضح و باقی به صورت محو دیده 

 
 .شوندمیدر شکل زیر، گوی قرمز به صورت واضح و باقی به صورت محو دیده 



 
 

Isolated select  : 

 یک کار این برای .رودمی کار به شود داده شنمای viewport در شده انتخاب آبجکت فقط اینکه برای Isolated select ابزار

 را کار این توانیدمی دیگر سوی از کلیک نمایید. Panel ابزار نوار در را Isolated select کلید و کنید انتخاب viewport آبجکت

 .دهید انجام کیبورد، روی SHIFT + I دهایکلی فشردن با یا Panel منوی از Show > Isolated select مسیر از

 XRay : 

 < Shading مسیر از توانیدمی همچنین .شودمی استفاده شفاف نیمه حالت به viewport در هاآبجکت تبدیل برای XRay ابزار

XRay منوی زاPanel ، حالت به XRay کنید سوییچ. 

 

 XRay active component : 

 همچنین .شودمی استفاده دیگر یهاآبجکت روی از فعال های component شنمای برای XRay active component ابزار

 .کنید فعال Panel منوی از Shading > X-Ray active component مسیر از را ابزار این توانیدمی

 XRay joints : 

در این صورت به   .شودمی استفاده shaded حالت در دیگر یهاآبجکت روی از کلت،اس مفاصل شنمای برای XRay joints ابزار

 انتخاب توانیدمی Panel منوی از Shading > XRay joints مسیر از همچنین را ابزار این .طور کامل روی مفاصل تسلط دارید

 .کنید

  :  < Joints Ray-XShadingبه طور مشابه

https://en.wikipedia.org/wiki/X-ray


 
 

 
 

Exposure  : 

 .شودمی استفاده شنمای صفحه ینایروش متنظی برای Exposure ابزار

 

Gamma  : 

 .شودمی استفاده تصویر در ها  midtone یروشنای یا استکنتر تنظیم برای Gamma ابزار

 
 



View Transformation  : 

 انتخاب را یرنگ فضای کار این د. برایشومی استفاده شنمای برای کار یرنگ فضای تغییر برای View Transformation ابزار

 .کنید انتخاب متفاوت View Transforme یک یکشوی لیست از استفاده با و کنید

 

 نکته : 

 .کند یپشتیبان را لابا کیفیت اتتنظیم تا باشد مناسب کیفیت با یگرافیک کارت به زهمج باید شما مسیست

 Channel Box / Layer Editor : 

Channel Box و Layer Editor ش ویرای برای attributeشوندمی استفاده آبجکت یک های. Channel Box تمام  attribute 

 موجود یهابجکتآ برای لایه ساختن برای Layer Editor و شودمی شامل را شوندمی استفاده آبجکت ویرایش برای که یهای

 Windows >  General Editors > Channel Box / Layerمسیر Channel Box / Layer Editor شنمای برای .است صحنه در

Editor کلیدهای یا از کنید دنبال منو نوار از را CTRL+A .استفاده نمایید  

 
 ی نمایید. ابانتخ status lineتوانید آیکون آن را از گوشه سمت راست همچنین می

 
 .شودمی نمایان تصویر مطابق Channel Box / Layer Editor در آن به مربوط های attribute کنید؛ انتخاب آبجکت یک



 
 

Transform node : 

 نود ؛کنید انتخاب viewport از یآبجکت ست.ا شده انتخاب آبجکت به مربوط transformation های attribute شامل شبخ این

Transform  شودمی فعال .NURBSSphere1  نود واقع در Transform آبجکت یک به مربوط NURBS sphere  یرمقاد .است 

  یک ماس ویر ینکها  یا .کنید ایجاد تغییراتviewport  در آبجکت روی تا کنید وارد transform مختلف هایرارامتپ در متغیر

attributeنود در Transform زمینه کنید؛ کلیک attribute سمت را ماوس گرنشان لاحا .آیدیم در یآب رنگ به  viewport،ببرید 

 همزمان توانیدمی همچنین شما .کند تغییر شده انتخاب attribute پارامترهای ات کنید درگ و دارید نگه را ماوس وسط کلید

 خواهیدمی هک یهای  attribute و دارید نگه راSHIFT  کلید کار این برای .کنید تنظیم attribute یک از شبی برای را مقادیر

  attribute تا کنید درگ و داشته نگه را ماوس وسط کلید ببرید،viewport  سمت را ماوس سپس ،کنید انتخاب را دهید تغییر

 کردنغیر فعال ایبر .کنید انتخاب را Visibility attribute ،آبجکت یک شنمای حالت تغییر برای .دهید تغییر را شده انتخاب های

 .کنید وارد Visibility شویرای کادر در را 1 ،آن شنمای برای و 0 ،آبجکت شنمای

 
SHAPES node : 

 مشاهده 1 – 58 تصویر در که همانطور ش،بخ این .دهدیم ارائه را آبجکت یک درخصوص مختصری لاعاتطا SHAPES نود

 viewport در NURBS sphere یک شما که یهنگام مثال، برای .دهدیم شنمای را شده انتخاب آبجکت شکل ماس ،شودمی

 با آبجکت که است این بیانگر NURBS عبارت اینجا در .شودمی گذارینام NURBSSphereShape1 ماس به کنید، ایجاد



 این که است این بیانگر Shape1 و شده ساخته کره یک که دهدیم نشانSphere  شده؛ ساخته NURBS اجزای از استفاده

 .استviewport در شده ایجاد کره شکل اولین

 
INPUTS node : 

  و کنید جادای viewport در sphere یک کار، این برای .شودمی استفاده آبجکت یک یهندس ساختارح اصلا برای INPUTS نود

را  Channel Box پنجره در INPUTS نود درواقع  makeNURBSphere1 سپس .است انتخاب حالت در که شوید مطمئن

 مقادیر توانیدمی لحا .شودمی داده شنمای بینید،می 1 – 58 تصویر در که sphere یهندس های attribute کنید؛ انتخاب

 .دهید تغییر نیاز مطابق را sphereیهندس

 
Layer Editor  : 

 Layers > Create Empty مسیر Layer Editor در جدید لایه ایجاد برای .دارد قرار Channel Box پایین Layer Editor ایضف

Layer را آبجکت  ،لایه به آبجکت یک افزودن برای .شد خواهد ایجاد جدید لایه یک کنید؛ انتخاب 1 - 5۹ تصویر به توجه با را 

 Add Selected گزینه .شودمی ظاهر معلق منوی یک دارید؛ نگه و کنید کلیک راست یخال لایه روی و کنید انتخاب viewport از

Object  شد خواهد افزوده لایه به شده انتخاب آبجکت کنید؛ انتخاب ومن از را. 



 
 توانیدمی ینهمچن شما .شودمی استفاده دارد، وجود صحنه در متعددی یهاآبجکت که یهنگام عمدتاً Layer Editor قسمت

 کادر کنید؛ کلیک بار دو هالایه از ییک ماس روی کار، این رای. بدهید تغییرLayer Editor از استفاده با هالایه رنگ و ماس

 از را آبجکت شنمای یچگونگ توانیدمی .کنید وارد Name متن کادر در را لایه نام .شودمی داده شنمای  Edit Layer گفتگوی

 ودشخ عادی حالت در آبجکت کنید، انتخاب لیست این از را Normal گزینه اگر .کنید انتخاب Display type یکشوی لیست

 .است شدن انتخاب قابل و ماندیم یباق

 



  .یستن کردن انتخاب قابل و شودمی داده شنمای  wireframe حالت در آبجکت کنید، انتخاب را Template گزینه اگر 

 
همانطور که  .نیست شدن انتخاب قابل و شودمی داده شنمای shaded حالت در آبجکت ،کنید انتخاب را Reference گزینه اگر

 نشده است. نمایانزارهای آن روی شکل شده است ولی اب انتخاب Moveبینید، با اینکه شکل و ابزار در شکل زیر می

 
 پایین در Color swatches رنگ هایهنمون .کنید تنظیم Visible تیک زدن با را آبجکت شدن داده شنمای توانیدمی همچنین 

 دیگر بین شدن داده تشخیص برای مجزا هویت یک آن به تا دهدیم را لایه برای رنگ یک انتخاب امکان شما به گفتگو کادر

 .بدهید هالایه

 
Attribute Editor  : 

 شده نتخابا آبجکت به شده اعمال متریال یا ابزار آبجکت، یک مختلف های attribute درباره اطلاعاتی Attribute Editor قست

 Windows  مسیر، نوم نوار از .شودمی استفاده آبجکت های attribute روی تغییرات ایجاد برای همچنین شبخ این .دهدیم ارائه

> General Editors > Attribute Editor ؛کنید انتخاب را Attribute Editor راست سمت viewport شودمی داده شنمای. 



 
 .کندمی کمک هاآبجکت مدیریت در شما به هک است attribute زبانه تعدادی شامل قسمت این

 
HOTKEYS  : 

  کار، این برای .دهید غییرت را موجود فرضپیش میانبرهای یحت یا کنید ایجاد را خودتان میانبر کلیدهای توانیدمی مایا در شما،

 Hotkey  ، 1 - 62 تصویر مطابق کنید؛ انتخاب منو نوار از را Window > Setting/Preferences > Hotkey Editorمسیر 

Editor  شودمی داده شنمای. 

 
 لحا .کنید انتخاب  Edit Hotkeys For یکشوی لیست از را hotkey هایبندیدسته از ییک میانبر، کلیدهای شویرای برای 

 میانبر لیدک یک و کنید کلیک دستور روی .کنید پیداEdit Hotkeys For  پایین شده داده شنمای لیست از را نظر مورد دستور

 .کنید وارد کیبورد از



 
 هایمآیت کنید؛ وارد Search نوار در را دستور نام .کنید جستجو Search By متن کادر انتخاب با را کاربردی دستور یک توانیدمی

 رنگ با نشده داده اختصاص هایکلید زبانه این در .شودمی ظاهر Keyboard زبانه ، Hotkey Editorاستر قسمت در شده فیلتر

 .نداشده مشخص ایفیروزه

 
10-4-1/2- Camera Panels 

 Hot Boxشناخت اصول کار با   -1-4/2

Hotbox  یک در منوها مآیت به سیدستر برای viewport کندمی کمک .Hotbox  حالت یا و ایحرفه حالت در که یهنگام 

 .است کارآمد بسیار کنید؛می کار صفحه تمام



 
 به یدسترس برای .کندمی کمک کار فضای در ماوس نشانگر از استفاده با ابزارها و منوها به یدسترس برای شما به قابلیت این

 hotbox از را کارتان برای زنیا مورد گزینه توانیدمی ،لحا .شودمی داده شنمای Hotbox دارید؛ نگه را SPACE کلید تور،سد این

 است. شده متقسی مرکز و بجنو ل،شما ،، غربشرق مجزای منطقه پنج به Hotbox .کنید انتخاب

 نکته : 

 یدسترس برای  Hotboxاز سپس ؛باشید داشته بیشتری فضای تا کنید خاموش را مایا درمحیط گوناگون UI عناصر توانیدمی شما

د ایجا مشخص ارک جریان یک خودتان برای که دهید انجام یهنگام را کار این اما .کنید استفاده مختلف هایابزار و دستورها به

 یک کردن یداپ برای شدن گیج احتمال تا کنید استفاده Hotbox جای به صفحه یلابا منو نوار از باید ابتدا در .باشید ردهک

 .دهید شکه را بعدی مراحل در دستور

 

 Graph Editorشناخت اصول کار با  -1-5/2

 آن وسطت که است …ت کاراکتر، احجام متحرک و ی، یکی از بهترین ابزارها برای کنترل انیم Maya Graph Editor پنجره

ها های بصری کلیدتوانید نمایشبا ویرایشگر گراف، شما می. انیمیشن، کنترل داشته باشید کلیدهای روی راحت خیلی توانیدمی

 .های انیمیشن را ویرایش کنیدو منحنی

 



 
 

 ذخیره کردن پروژه  شناخت اصول -1-6/2 

 توان اقدام نمود:های زیر میاز روش همانند اشکال، کردن پروژه برای ذخیره

  نواردر status line  کلیدsave scene. 

 
  از طریق منویFile  گزینهsave scene ،)ذخیره روی فایل جاری( save scene as و در  )جهت ذخیره با نام جدید

شود. به گذاری از نام فایل قبلی مجزا می)ذخیره فایل با نام جدید که با شماره Increment and Saveو  محل جدید(

رمان، با نام فوسط این جدید در فایل و ذخیره ت تباشد؛ پس از اعمال تغییرا maya.ma  طور مثال اگر نام فایل اول،

 .شودذخیره می maya0001.maجدید 

 



 

 
 از طریق کلید میانبر  Ctrl + S  وCtrl + Shift + S. 

 ویر:افزار از مسیر زیر مطابق تصاز طریق ذخیره خودکار توسط نرم 



 
 نمود: به صورت زیر تنظیمهای مربوط به ذخیره خودکار را توان بخشمی Enableبا فعال کردن گزینه 

Prompt before save ای جهت : نمایش پنجرهsave سازی.قبل از ذخیره 

 

 



 
Limit autosave جویی در حافظه(.)جهت صرفه شوندمیخیره هایی که به طور خودکار ذ: محدود کردن تعداد فایل 

Number of autosave های سازی خودکار به این صورت که فقط به تعداد تعیین شده، از آخرین فایل: تعداد ذخیره

 .شوندمیمانند و بقیه حذف ذخیره شده روی سیستم باقی می

Interval (minute) سازی خودکار.: فواصل زمانی بین ذخیره 

Autosave destination کند. )سازی خودکار را تعیین می: محل ذخیرهProject  ،در پروژه جاری :Name folder  در :

 اید(پوشه جدیدی که نام آن را در این قسمت وارد نموده
 شناخت اصول باز کردن پروژه موجود -1-7/2

 توان اقدام نمود:های زیر میبرای باز کردن پروژه موجود از روش

  نواردر status line  کلیدopen scene. 

 
  از طریق منویFile  گزینهopen scene 

 
  از طریق کلید میانبرCtrl + O. 

 

 

 
 


